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Einleitung 

Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des MasterPort.  

 

Dieses Handbuch gilt für den MasterPort. Wie alle anderen Produkte aus dem Hause LSS GmbH 
unterliegt der MasterPort einer ständigen technischen Weiterentwicklung. Deshalb werden hier 
unter Umständen Funktionen und Einstellungen beschrieben, die für den von Ihnen genutzten 
MasterPort nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

Hier erhalten Sie zusätzliche Informationen.  

 

 

Ein Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

 

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem MasterPort ist nicht gefährlich. Schutzisolierung und weitere Sicherheits-
maßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und Strö-
men in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Trennen Sie vor der Abnahme der Rückwand das Gerät unbedingt vom Netzteil! 

 Reparaturen dürfen nur von einem autorisierten Händler oder von Mitarbeitern der 
LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Der MasterPort ist für einen 24h Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes beachten:  

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. Be-
nutzen Sie nur ein angefeuchtetes Tuch 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf das 
Gerät! 

 Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 
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Der Masterport 

Überblick 

 

Der LSS MasterPort ist ein Netzwerkknoten, Konverter und Merger für die moderne Lichttechnik. 
Er kann, je nach Bestückung mit DMX-Ports, bis zu vier Universes von Ethernet auf DMX und um-
gekehrt umsetzen. In jedem Universe können dabei bis zu vier Sender nach dem HTP-Prinzip 
germergt werden. Dafür unterstützt er alle gängigen Lichtnetzwerkprotokolle und ist nach ANSI 
E1.20 2006 RDM-ready.  

 

Der LSS MasterPort ist in seinen Dimensionen eins sehr kompaktes Gerät und kann deshalb auch in 
sehr schwierigen örtlichen Gegebenheiten zum Einsatz kommen. Die Spannungsversorgung kann 
dabei wahlweise mittels einer externen Versorgungsspannung von 48V oder mit Power-over-
Ethernet nach IEEE 802.3af Standard erfolgen. So kann der LSS MasterPort problemlos in Wand-
verkleidungen, Versatzkästen usw. eingebaut werden. Natürlich ist er auch in einem extra Stahl-
blechgehäuse lieferbar und optional mit einem internen Netzteil. 

 

Wie viele andere Geräte aus dem Haus LSS auch, ist der MasterPort explizit für den Einsatz in Büh-
nennähe konzipiert. Das bedeutet, er ist passiv gekühlt und dadurch absolut geräuschlos, das Dis-
play zur Konfiguration ist abschaltbar und nicht zuletzt kann der LSS MasterPort vollständig von 
der Software LSS ConfigCore fernkonfiguriert werden.  

 

Unterstützte Protokolle 

Der LSS MasterPort unterstützt folgende Protokolle: 

 

 Art-Net  ShowNet 

 AVAB/UDP  AVAB/IPX 

 sACN  DMX512 

 

Anschlüsse 

 

Ethernet:  1x RJ45, 100MBit 

 

DMX:   der LSS MasterPort wird mit drei DMX-Anschlussvarianten angeboten 

   2x DMX-In/2x DMX-Out 

   4x DMX-In 

   4x DMX-Out 

   alle DMX-Anschlüsse sind unabhängig optisch potentialgetrennt  
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Funktionsübersicht 

DMX 

DMX-Eingang 

Der MasterPort kann am DMX-Eingang Signale mit maximaler Datenrate (44/s = Protokollänge 
22,4ms) und minimalem MAB (4 µs) empfangen. Die Timeout-Zeit bis Empfangsausfall beträgt 2s. 
Die DMX-Signale werden durch den Controller logisch aufbereitet und ausgewertet. 
 

 

DMX-Ausgänge 

Gemeinsam für alle DMX-Ausgänge sind folgende Parameter einstellbar: 

 Verhalten bei Empfangsausfall aller Quellen (Abschalten, Halten, Nullen senden) 

 Breaklänge 90…999 µs 

 Mark After Break 20…999 µs 

 

Dadurch können Sie den MasterPort an jedes Endgerät anpassen. 

 

 

Der MasterPort kann nur als Protokollkonverter zwischen DMX und 
ethernetbasierenden Netzwerkprotokollen eingesetzt werden. Für Konvertierungen von 
Ethernet-Protokollen muss ein LSS MasterGate eingesetzt werden! 
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Ethernet 

Datentransferrate 

Der MasterPort zeichnet sich durch hohe Durchsatzrate und geringe Latenz (Verzögerungszeit) in 
beiden Richtungen aus. Die Netzwerkschnittstelle ist 100MBit-fähig und die interne CPU arbeitet 
mit einem sehr schnellen Realtime-Multitasking-Betriebssystem. So ist ein maximaler Durchsatz 
von >1000 Netzwerk-Paketen pro Sekunde möglich. 

 

 

Netzwerkprotokolle 

Das Standard-Netzwerkprotokoll des MasterPort bei Auslieferung ist das herstellerübergreifende 
Art-Net von ArtisticLicence. Die aktuell eingesetzte Protokollversion ist 1.4am.  

 

Für AVAB Safari VLC, transtechnik NT oder zur Kommunikation mit Fremdgeräten von LDDE u.ä. 
wird das ältere Protokoll AVAB/IPX unterstützt. Für transtechnik NT – und ETC - Anlagen wird das 
Protokoll AVAB/UDP unterstützt, das einer direkten Umsetzung von AVAB/IPX auf TCP/UDP ent-
spricht. Für Anlagen der Firma Strand Lighting wird das ShowNet - Protokoll unterstützt. Daneben 
wird das Streaming-Protokoll sACN als Untermenge des ANSI-Standards E1.17 unterstützt, das auf 
Multicast basiert. Der MasterPort benutzt hierfür IGMPv2. 

 

 

Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des Mas-
terPort und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur mit 
dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und den MasterPort komplett 
remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der MasterPort problemlos mit Art-Net-Softwaretools an-
derer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter 
www.artisticlicence.com). Selbstverständlich hat der MasterPort wie alle anderen Art-Net-Geräte 
eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool ist 
auch eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier nur eine 
Untermenge des MasterPort konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der MasterPort mit 
ConfigCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im IP-
Adressbereich des MasterPort liegt. 
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Licht-Parameter 

Für alle Lichtprotokolle können Sie folgende Parameter einstellen: 

 minimale Senderate ohne Werteänderung 20 ms … 4s 

 Timeout-Zeit 1...999 s (Halten usw. wird pro DMX-Out eingestellt, s. dort) 

 Timeout ist nur global einstellbar, wird aber für jedes verwendete Subnetz/Universe einzeln 
überprüft 

 

 

IP-Parameter 

Für alle auf TCP/IP basierenden Lichtprotokolle können Sie weiterhin folgende Parameter festle-
gen: 

 IP-Adresse  Manuell / Art-Net 2.x.x.x / Art-Net 10.x.x.x / DHCP 

 IP-Subnetz-Maske 

 Gateway-IP 

 

 

Merge-Verhalten 

Der MasterPort kann bei Anlagen, die auf dem gleichen Subnetz/Universe senden, bis zu 4 Anlagen 
HTP-mergen. Dies zeichnet ihn von den meisten anderen Geräten dieser Art aus. Art-Net sieht z.B. 
hier nur 1 oder max. 2 Anlagen vor. 

Es werden ebenfalls Prioritäten unterstützt, wenn dies das Lichtprotokoll zulässt. Es werden aber 
keine herstellereigenen Erweiterungen, wie z.B. „Prioritäten pro Kreis“, unterstützt. 
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Anzeige-, Anschluss- und Bedienelemente 

Überblick 

Auf der Frontseide des LSS MasterPort befinden sich die DMX-Ports und der Konfigurationsbe-
reich. 

 

 

 

BetriebsLED 

 

 

Menüeinstellung 

 

 

 

DMX-Ports 

 

 

 

 

 

BetriebsLED 

Über die LEDs an der Frontseite werden die Betriebszustände des MasterPort angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

LINK/DATA gelb Ein: Ethernet-LINK, keine Daten 

Blinkt: Ethernet-LINK, Daten 

Aus: kein LINK 

 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 
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Menüeinstellung und Display 

Die Konfiguration des MasterPort erfolgt lokal über ein komfortables Menüsystem. Zu diesem 
Zweck enthält das Gerät ein blau-weiß leuchtendes 20x4 LCD-Display mit stromsparender LED-
Hintergrundbeleuchtung und langer Lebensdauer. Die Lebensdauer wird noch um ein Vielfaches 
erhöht, wenn der Bildschirmschoner verwendet wird.  

 

Bedient wird das Menü mit vier Tasten, die bereits von anderen Geräten von LSS bekannt sind. 

 

 

 

 

 

 

 

 

Taste Bedeutung 

MENU Zugang zu Haupt- und Untermenüs 

← Scroll durch die Menüs 

→ Scroll durch die Menüs 

OK Bestätigung von Einstellungen 

 

Die Tasten ← und → haben eine Beschleunigungsfunktion, die beim Festhalten die Eingabe großer 

Zahlen erleichtert. Ab 100 bzw. 1000 wird jeweils um den Faktor 10 beschleunigt. 

 

Verwenden Sie den Bildschirmschoner! Dies verlängert die Lebensdauer des Displays um 
ein Vielfaches.  

 

 

Im Menü können Sie den Kontrast  des Displays einstellen. Ein Nachregeln ist aber norma-
lerweise nicht nötig, da das Display bereits temperaturkompensiert ist. 

 

 

Anschlüsse 

Die Anschlüsse des LSS MasterPort befinden direkt am Gerät. Die DMX-Ports befinden sich dabei 
an der Frontseite, während sich der Anschluss für die externe Spannungsversorgung und die RJ-45-
Buchse sich auf der Rückseite des MasterPort befinden.  
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Konfiguration des MasterPort 

Hinweise zur Bedienung des Menüs 

Aufbau und Auswahl 

Die Menüstruktur des MasterPort ist hierarchisch angeordnet. Die erste Ebene ist der Grundzu-
stand, von dem der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die weiteren Unter-
menüs thematisch in Ebenen unterteilt.  

 

Menüauswahl 

Mit den Pfeiltasten ← und →werden die unterschiedlichen Menüpunkte ausgewählt und Schaltflä-

chen durch ein wanderndes ►. Ein Drücken auf „OK“ wählt diesen Menüpunkt oder die Schaltflä-
che aus. 

 

Änderung von Parametern 

Der ausgewählte Parameter wird mit einem  invers blinkenden  ersten Zeichen dargestellt und 
kann nun durch Drücken der Pfeiltasten verändert werden. Drücken der Taste „OK“ übernimmt die 
Einstellung, die veränderten Parameter werden dann sofort wirksam. 

 

Das Betätigen der Taste „MENU“ führt den MasterPort in das vorhergehende Menü zurück. Bevor 
das übergeordnete Menü angezeigt wird, werden Sie gefragt, ob Sie die geänderten Werte spei-
chern möchten.  

 

Speichern von Parametern 

Wählen und bestätigen Sie „OK“ werden die Werte dauerhaft gespeichert. Mit „MENU“ kehren Sie 
in das vorhergehende Menü zurück, geänderte Werte werden nicht gespeichert, auch wenn sie 
bereits temporär eingestellt waren. 

 

Wird über einen einstellbaren Zeitraum keine Taste nicht betätig, wird der Grundzustand aktiviert. 
Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt und das eingegebene Pass-
wort gelöscht. Nicht gespeicherte Änderungen im aktuellen Menü gehen verloren. 
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Legende zur Schematische Darstellung des Menüs 

Der Aufbau des Menüs und die Konfigurationsmöglichkeiten werden im Folgenden schematisch 
dargestellt. Die verwendeten Symbole haben folgende Bedeutung: 

 

Symbol Bedeutung 

OK Auswahl „OK“ führt zum nächsten Menüpunkt bzw. hat folgende Auswirkung 

MENU Auswahl „MENU“ führt zum nächsten Menüpunkt bzw. hat folgende Auswirkung 

 

 

 

 

 

 

 

 

 

 

 

 

Display-Anzeige 

 

Anzeigenname 

 

 

 

 

Anzeigen/Parameter zur Auswahl 

 

 

 

⇆ Auswahl mit den Pfeiltasten 
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Grundzustand 

 

Im Grundzustand scrollt das Menü des MasterPort durch verschiedene Diagnoseseiten. Diese Sei-
ten geben einen schnellen Überblick über verschiedene Einstellungen und den Betriebszustand 
des Geräts.  

 

Es ist möglich, den automatischen Scroll mit Drücken der Taste „OK“ zu unterbrechen und mit den 
Pfeiltasten manuell die Seiten aufzurufen. Der automatische Scroll wird mittels eines blinkenden 
-Symbols rechts oben angezeigt. Beim Wechsel zum manuellen Scroll ändert sich das Symbol in 
II. 
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Hauptmenü 

PIN-Abfrage 

Vom Hauptmenü aus werden alle anderen Menüs, wie Anzeige-, Konfigurations- und weitere Ein-
stellungsmenüs aufgerufen. Falls eine PIN vergeben wurde, wird diese vor dem Hauptmenü abge-
fragt: 

 

 
 

Die Eingabe der Pin erfolgt mit dem Encoder. Zur Sicherheit wird vor und nach dem Scrollen nur 
[*****] angezeigt. 

 

Aufbau Hauptmenü 

Vom Hauptmenü aus werden alle anderen Menüs aufgerufen. Um vom Grundzustand aus das 
Hauptmenü aufrufen zu können, muss die Taste „MENU“ gedrückt werden.  

Das Hauptmenü ist unterteilt in Monitoring-Menüs, Konfigurationsmenüs und weitere Einstellun-
gen. 

 

 
 

Auswahl Bedeutung 

View Auswahl der Netzwerk- und DMX-Monitore 

Config Auswahl des Menüs zur Einstellung des MasterPort 

Options Auswahl des Menüs zur Einstellung der Zusatzfunktionen 

Version Auswahl der Versionsinformationen 

MENU Rückkehr in den Grundzustand 

OK Bestätigung der Auswahl 
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View-Menü 

Mit den Monitoren im View-Menü erhalten Sie einen Überblick über die aktuellen Einstellungen 
des MasterPort. Aktuelle Ereignisse, Daten-In- und –Output werden ebenso dargestellt wie die 
Merge-Situation. Die Anzeigen im View-Menü verstehen sich als Monitore und sind in Echtzeit. 
Dadurch lassen sie sich problemlos als Überwachungs- und Diagnosetools einsetzen. 

 

Aufbau des View-Menüs 
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View→DMX 

Dieser Monitor gibt einen Überblick über die Aktivitäten an den DMX-Ports. Im Untermenü für alle 
Ports können die Signale für jedes Bit hexadezimal oder prozentual dargestellt werden.  

 

Anzeige Bedeutung 

DMX 1…4 DMX-Port 1…4 

IN Das Symbol ist nur bei DMX-In Ports vorhanden. 

Voll: am DMX-Eingang wird ein korrektes DMX-Protokoll empfangen 

E: DMX-Protokoll am Eingang ist ungültig (Startcode oder Timing) 

Leer: kein Signal am DMX-Eingang 

Out Das Symbol ist nur bei DMX-Out Ports vorhanden. 

Voll: am DMX-Ausgang wird ein DMX-Protokoll ausgesendet 

H: DMX-Ausgang ist auf HOLD und hält die letzten Daten 

Z: DMX-Ausgang ist auf HOLD und sendet Nullprotokolle 

Leer: DMX-Ausgang ist abgeschaltet 

Cnt Anzeige der gesendeten Pakete pro Sekunde 

F Anzeige der Framerate pro Sekunde 

MENU Rückkehr ins übergeordnete Menü 

OK Auswahl bestätigen 

 

View→Network 

In diesem Monitor werden die aktuellen Einstellungen an den DMX-Ports angezeigt.  

 

Anzeige Bedeutung 

1…4 DMX 1…4 

Act voll: auf dieser Subnet/Universe-Kombination wird Licht empfangen 

leer: auf dieser Subnet/Universe-Kombination wird kein Licht empfangen 

Sub logisches Subnet (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist, wird „-“ angezeigt. 

Uni Universe (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist, wird „-“ angezeigt. 

OK Menü aufrufen/Auswahl bestätigen 

MENU Rückkehr ins übergeordnete Menü 
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View→NWCount 

Dieses Auswahlmenü führt zu Monitoren, die einen Überblick über eigehende und ausgehende 
Daten und Datenpakete geben. Die Monitore geben ihre Informationen sehr umfangreich wieder, 
so dass man diese Informationen zur Netzwerkdiagnose nutzen kann. 

 

Anzeige Bedeutung 

In Aufruf Netzwerkzähleranzeigen für empfangene Daten 

Out Aufruf Netzwerkzähleranzeigen für gesendete Daten 

Data Aufruf Netzwerkzähler für Datenpakete 

OK Menü aufrufen 

MENU Rückkehr ins übergeordnete Menü 

 

 

View→NWCount→In/Out 

Anzeige Bedeutung 

Count  

kByte empfangene kByte 

Packets empfangene Pakete 

Errors Summe der Empfangsfehler 

Errors1  

Dropped Empfangsüberlauf durch zu viele Pakete 

Overrun (nur In) Empfangsüberlauf durch zu viele Pakete 

Aborted (nur Out) Abgebrochene Pakete 

Length (nur In) Pakete mit Längenfehler 

Carrier (nur Out) Ethernet-Carrier verloren 

Errors2  

CRC (nur In) CRC-Empfangsfehler 

Heartbt (nur Out) Ethernet Heartbeat verloren 

Frame Frame Fehler 

FIFO Überlauf Ethernet FIFO 

MENU Rückkehr ins übergeordnete Menü 
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View→NWCount→Data 

Anzeige Bedeutung 

Rx Empfangene Datenmengen 

Tx Gesendete Datenmengen 

Pack./s Pakete pro Sekunde 

kByte Datenmenge in kByte 

MENU Rückkehr ins übergeordnete Menü 
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Config-Menü 

Im Config-Menü können Sie die vielfältigen Einstellungsmöglichkeiten des MasterPort komfortabel 
ändern. Zu Ihrer eigenen Sicherheit müssen Sie vor jeder Änderung der Einstellungen diese Ände-
rung auch bestätigen.  

 

Aufbau des Config-Menüs 

 

 
 

 

Menü Einstellungsmöglichkeiten 

Routing Einstellung des Merge-Verhaltens 

DMX Einstellung des Verhaltens der DMX-Ausgänge bei Signalverlust 

Network Einstellung der Ethernet-basierenden Netzwerkprotokolle 

OK Menü aufrufen 

MENU Rückkehr ins übergeordnete Menü 
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Config→Routing 

Im Routing findet die Zuordnung der DMX-Ports zu den Ethernet Universes und Subnets statt. Au-
ßerdem wird hier festgelegt, was gemergt wird und ob der Port überhaupt aktiv ist. 

Das Menü ist unterschiedlich, je nachdem ob der DMX-Port ein IN oder OUT ist. 

 

DMX-In 

Werden am DMX-In Daten empfangen, sendet der MasterPort diese auf dem eingestellten 
Subnet/Universe (mit dem eingestellten Sende-Licht-Protokoll) aus, falls der Mode auf „On“ steht. 
Bei „Off“ wird nichts gesendet.  

 

 
 

Auswahl Bedeutung 

Mode Off: Ethernet wird nicht gesendet, DMX-In abgeschaltet 

On: Ethernet wird gesendet, wenn DMX-In aktiv 

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

Priorität Einstellung der Sende-Priorität (lichtprotokollabhängig) 

OK Menü aufrufen 

MENU Rückkehr ins übergeordnete Menü 
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Da das Ethernet-Sendeprotokoll AVAB/UDP Subnets und Prioritäten unterstützt, so gibt es eine 
weitere Zeile, wenn man den Cursor abwärts bewegt; die Anzeige rollt nach oben. 

  

Werden mehrere IN-Ports auf die gleiche Subnet/Universe-Kombination eingestellt, so werden 
diese DMX-In-Signale bereits im MasterPort gemergt und als gemeinsames Universe nur 1x über 
Ethernet ausgesendet. Natürlich werden auch hier (außer der eingestellten Mindest-Senderate) 
nur Änderungen übertragen. 

Sind zusätzlich unterschiedliche Prioritäten eingestellt (z.B. bei AVAB/UDP), so wird das Protokoll 
mit der höchsten eingestellten Priorität gesendet. 

 

DMX-Out 

Der DMX-Out ist aktiv, wenn der MasterPort über Ethernet mindestens eine Anlage auf dem ein-
gestellten Subnet/Universe empfäangt. Bei bis zu 4 gleichen Quellen werden alle nach dem HTP-
Prinzip zusammengefasst. 

Fällt der letzte aktive Sender aus, wird nach Verstreichen des Licht-Empfangstimeouts der Out ab-
geschaltet bzw. bei „HOLD“ der letzte Wert gehalten oder bei „Zero“ Nullen gesendet. 
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Auswahl Bedeutung 

Mode Off: Ethernet wird nicht empfangen, DMX-Out abgeschaltet 

 

Single:  

Es werden nur die vom ersten Sender empfangenen Lichtdaten verwen-
det. Sollten gleichzeitig von mehreren Sendern Telegramme mit dem ein-
gestellten Subnetz und Universe anliegen, wird nur der als erstes er kann-
te Sender berücksichtigt. Die Sender-Erkennung erfolgt bei AVAB/IPX di-
rekt durch Auswertung der MAC-Adresse (Ethernetadresse), bei sACN 
nach der Geräte-ID und bei allen anderen Protokollen durch die IP-
Adresse des Senders, die für jeden Sender individuell sein muss. Bei Aus-
bleiben des Sendersignals wird nach der Timeout-Zeit (Pufferzeit) ggf. ein 
anderer Sender ermittelt (Prinzip: „Der erste darf“). 

 

Merge4: 

Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-Prinzip 
zusammengefasst. Sollten gleichzeitig von mehr als 4 Sendern Telegram-
me mit dem Subnetz und Universe dieses Ausgangs anliegen, werden nur 
die ersten 4 erkannten Sender berücksichtigt. Bei Ausbleiben eines Sen-
dersignale wird nach der Timeout-Zeit ggf. ein anderer Sender ermittelt 
(Prinzip: „wer zuerst kommt“). 

 

DmxIn1: Es werden nur DMX-Lichtdaten verwendet. 

 

All: Es werden die Daten aus Ethernet und DMX-In verwendet.  

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Bei Protokollen mit Prioritäten gibt es folgende Besonderheiten: 

Protokoll Prioritätsbehandlung 

AVAB/UDP Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden (alte transtechnik-Versionen, DigiPlus usw.) wer-
den immer mit der höchsten Priorität zusammen HTP-gemergt. 

sACN Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden, werden wie Priorität 100 behandelt. 
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Config→DMX 

In diesem Menü werden das Verhalten der DMX-Out bei Empfangsausfall sowie das Timing des ge-
sendeten DMX-Protokolls festgelegt. 

 

 
 

Auswahl Bedeutung 

DMX-Out Off: bei Empfangsausfall wird der DMX-Out abgeschaltet 

Hold: der letzte empfangene Stand wird unverändert weitergesendet 

Zero: bei Empfangsausfall werden Nullen weitergesendet 

Break hat keine Bedeutung 

MAB hat keine Bedeutung 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network 

Im Network-Menü werden die auf dem Ethernet basierenden Netzwerkprotokolle eingestellt. 
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Config→Network→Light 

In diesem Menü werden die Licht-Netzwerk-Menüs für Empfang und Senden aufgerufen. 

Der MasterPort kann mit unterschiedlichen Licht-Protokollen gleichzeitig senden und empfangen! 

 

Auswahl Bedeutung 

Receive Aufruf des Netzwerk-Menüs für Licht-Empfang 

Transmit Aufruf des Netzwerk-Menüs für Licht-Senden 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Config→Network→Light→Receive 

In diesem Menü wird das Licht-Empfangsprotokoll eingestellt. 

 

Auswahl Bedeutung 

Protocol Einstellung des Netzwerkprotokolls für Licht-Empfang: 

Art-Net 

AVAB/IPX 

AVAB/UDP 

ShowNet 

sACN 

Timeout Einstellung des Timeouts für Lichtprotokolle  

0…999 s  (0 = letztes Protokoll halten) 

Name Einstellung des Art-Net ShortName zur Benennung des MasterPort 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network→Light→Transmit 

In diesem Menü wird das Licht-Sendeprotokoll eingestellt. Die Ethernet-Senderate ist bei Ände-
rungen am DMX-In minimal 20ms und damit sicher unter der minimalen DMX-Protokolldauer von 
22,4ms. Wenn sich nichts ändert, kann hier eine Mindest-Senderate eingestellt werden. 

 

Auswahl Bedeutung 

Protocol Einstellung des Netzwerkprotokolls für Licht-Senden: 

Art-Net 

AVAB/IPX 

AVAB/UDP 

ShowNet 

sACN 

TX Rate Einstellung der Mindest-Senderate für Lichtprotokolle, wenn sich keine 
Werte ändern.  

20ms, 40ms, 80ms, 100ms, 200ms, 500ms, 1s, 2s, 3s, 4s  

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network→IP Mode 

In diesem Menü wird der Erhalt der IP-Adresse eingestellt. Für Art-Net gibt es nach Art-Net Spezifi-
kation 2 feste Möglichkeiten, 2.x.y.z und 10.x.y.z. Dabei wird die IP unter Einbezug der Hersteller-
ID und der MAC-Adresse gebildet. Außerdem kann die IP-Adresse sowohl vollkommen frei als auch 
per DHCP eingestellt werden. 

 

Auswahl Bedeutung 

IP Mode Bezug der IP-Adresse: 

Manual: freie Einstellmöglichkeit, siehe TCP/IP-Menü 

Art-Net 2: Art-Net-Adresse im 2er Netz 

Art-Net 10: Art-Net-Adresse im 10er Netz 

DHCP:  wenn DHCP-Server im Netzwerk vorhanden 

Media Auto Neg: automatische Übertragungsgeschwindigkeit 

100 Full: 100Mbit Full-Duplex 

100 Half: 100Mbit Half-Duplex 

10 Full: 10Mbit Full-Duplex 

10 Half: 10 Mbit Half-Duplex 

UDP CS On:  UDP-Checksum wird bei jedem Paket berechnet 

Send Off: UDP-Checksum wird beim Senden nicht kontrolliert 

Recv Off: UDP-Checksum wird beim Empfangen nicht kontrolliert 

Off:  UDP-Checksum wird nicht kontrolliert 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Wenn DHCP eingestellt wird und kein DHCP-Server vorhanden ist, arbeitet der Master-
Port mit der Default-IP 0.0.0.0. Diese ist als Quelladresse zulässig, sollte allerdings nicht 
verwendet werden, da Probleme nicht auszuschließen sind. 

 

Config→Network→TCP/IP 

In diesem Menü kann im IP-Mode „Manual“ die IP-Adresse, die Netzwerkmaske und das Gateway 
frei eingestellt werden. Die Angabe des Gateways ist normalerweise nicht erforderlich, da Licht 
nicht geroutet wird. In allen anderen IP-Modi ist nur das Gateway frei einstellbar. 

 

Auswahl Bedeutung 

IP IP-Adresse 

SN Netzwerkmaske 

GW Gateway 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Options 

Im Menü Options werden die Zusatzeinstellungen des MasterPort festgelegt. 
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Auswahl Bedeutung 

Scrsaver Aufruf des Bildschirmschoner-Menüs 

Security Aufruf des Sicherheits-Menüs 

Defaults Aufruf des Menüs zum Defaultwerte laden 

Reset Reset des MasterPort 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Options→Scrsaver 

Der Bildschirmschoner schaltet nach einer einstellbaren Zeit das Backlight des Display aus und ver-
längert dadurch dessen Lebendauer. Beendet wird er durch Tastendruck oder durch bestimmte 
Remote-Befehle per Art-Net. 

Ereignisse an den DMX-Ports oder am Ethernet schalten den Bildschirmschoner aus und zeigen die 
jeweilige Statusseite. Dieses Verhalten ist abschaltbar, falls plötzlich aufblinkende Displays stören 
könnten (z.B. auf Bühnen). 

 

Auswahl Bedeutung 

Scrsaver Timeout für Backlight-Abschaltung des Displays  

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 
6h, 8h, 12h, 24h)  

Events On: Statusänderungen an DMX-In/Out oder Ethernet schalten Bild
 schirmschoner aus und zeigen die jeweilige Statusseite an 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

Contrast Einstellung des Kontrasts des Displays 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Options→Security 

Im Sicherheits-Menü kann eine PIN für die Lokalbedienung vergeben sowie die Remote-
Programmierung per Art-Net gesperrt werden. 

 

Auswahl Bedeutung 

Pin Hauptmenü-Pin 

0…30000s (0 = aus) 

Remote On: MasterPort ist per Art-Net programmierbar 

Off: MasterPort ist nicht per Art-Net programmierbar 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Obwohl das System eine Auswahl aus 30.000 möglichen PINs bietet, kann eine ab-
solute Sicherheit nicht gewährleistet werden! Treffen Sie geeignete Maßnahmen 
vor Ort, um einen nicht autorisierten Zugriff zu verhindern! 

 

 

Options→Defaults 

Hiermit werden die Werkseinstellungen geladen. Zur Sicherheit gegen ungewolltes Überschreiben 
muss man 2x mit „Ok“ bestätigen. 

Zu den Werkseinstellungen siehe Kapitel „Schnellkonfiguration“. 

 

 

Options→Reset 

Es wird ein CPU-Reset ausgelöst. Ein Reset dauert beim MasterPort nur max. 2 Sekunden, so dass 
nachfolgende Geräte nicht in Timeout gehen sollten. 

 

Beim Ändern folgender Einstellungen führt der MasterPort nachfolgend automatisch einen Reset 
aus: 

 Lichtempfangsprotokoll 

 Lichtsendeprotokoll 

 IP-Mode 

 IP-Adresse 

 Netzwerkmaske 

 Gateway 

 Defaultwerte laden 
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Version 

 

 
 

Anzeige Bedeutung 

© 2011 LSS GmbH Hersteller 

Ver. 1.20 Rev. 06 Software-Version 

Nov 02 2011 11:01:10 Datum und Uhrzeit 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Schnellkonfiguration 

Voraussetzung für die Schnellkonfiguration: es wurden vorher unter Options→Defaults die Werks-
einstellungen geladen. 

 

Werkseinstellungen 

Die Werkseinstellungen des MasterPort sind: 

 Netzwerkprotokoll:   Art-Net (Empfang und Senden) 

 IP-Mode:   Art-Net 2er Netz 

 IP:     nach Art-Net Standard (2.x.y.z) 

 Netzwerk-Maske:  255.0.0.0 

 Gateway:   192.168.172.254 

 Mindest-Senderate:  1/s 

 Empfangstimeout:   8 s 

 Routing DMX-Ports 1…4: Subnet 0, Universe 0…3 

 Routing DMX-In:  Ethernet-Senden ON, Priorität 0 

 Routing DMX-Out:  Ethernet-Empfang:  MERGE4 

 DMX-Out Verhalten:  OFF  (Abschalten bei Empfangsausfall) 

 DMX-Out Timing:  Break:  200 µ 

MAB:  20 µ 

 Art-Net ShortName:   LSS MasterPort 

 Art-Net LongName:   MasterPort  (c)2009 LSS GmbH      Version x.xx 

(wird erst ab S/N 0070 unterstützt) 

 Bildschirmschoner:  15 min, aus bei Statusänderungen 

 Pinabfrage:   aus 

 Art-Net Fernsteuerung: ein 
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Anhang A 

Besonderheiten der Netzwerkprotokolle 

Die Netzwerkeinstellungen (IP-Mode, IP-Adresse, Netzwerkmaske) des MasterPort wirken sich bei 
den verschiedenen Lichtprotokollen unterschiedlich aus: 

 

Licht-
Protokoll 

IP-Besonderheiten 

Art-Net IP-Mode, IP-Adresse und Netzmaske wirken sich direkt auf Art-Net aus. Aus Kompa-
tibilitätsgründen sollte immer der automatische IP-Mode „Art-Net2“ verwendet 
werden. 

Z.B. kommen DMX-Workshop oder GrandMA nur mit dem 2er Netz klar. 

AVAB/IPX IP-Mode, IP-Adresse und Netzmaske wirken sich überhaupt nicht auf AVAB/IPX aus, 
da dieses ein Novell-Protokoll ist. 

Der MasterPort kann aber trotzdem remote über Art-Net konfiguriert werden, dafür 
sind IP-Mode, IP-Adresse und Netzmaske relevant  -zur Kompatibilität auch hier am 
besten „Art-Net2“ verwenden. 

AVAB/UDP IP-Mode, IP-Adresse und Netzmaske wirken nicht auf AVAB/UDP aus, da AVAB/UDP 
mit  Broadcasts arbeitet. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort über Art-Net remote konfigurieren. 

ShowNet IP-Mode, IP-Adresse und Netzmaske wirken sich auf ShowNet aus.  

Häufig wird 192.168.0.x oder 192.168.1.x verwendet. Die Netzwerkmaske sollte 
255.255.255.0 sein.  

Um dies einstellen zu können, muss der IP-Mode „Manuell“ sein (oder DHCP, falls es 
einen entsprechenden DHCP-Server im Netz gibt). 

Der MasterPort kann trotzdem remote über Art-Net konfiguriert werden, allerdings 
beherrscht nicht jede Fremdsoftware Art-Net mit derart abweichenden IP-Adressen. 

sACN IP-Mode, IP-Adresse und Netzmaske wirken sich nicht auf ACN aus, da ACN ein 
Multicast-Protokoll mit der IP 239.255.x.y ist. Dieses wird unabhängig empfangen. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort über Art-Net remote konfigurieren. 
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Die einstellbaren Parameter Subnet und Universe unterscheiden sich wie folgt: 

 

Protokoll Universe Subnet Besonderheiten 

Art-Net 0…15 0…15 Der MasterPort kann auf jedem einzelnen DMX-Port mit ver-
schiedenem Subnet und Universe arbeiten. 

Dies ist z.B. mit dem DMX-Workshop nicht einzeln einstellbar, 
nur mit dem LSS-Softwaretool. 

AVAB/IPX 1…12 0…9  

AVAB/UDP 1…32 0…9 Bei DMX-IN: Sende-Priorität 0…200 einstellbar. 

ShowNet 1…36 nicht 
vorhan-
den 

Bei ShowNet gibt es eigentlich keine Universes,  alle 
Dimmerdaten werden in einem 18432 Kreise großen Feld dar-
gestellt. In älteren Anlagen (5xx) konnte man dies auch konfi-
gurieren. 

Trotzdem hat sich in der Praxis die Einteilung in Vielfache von 
512 durchgesetzt (wegen DMX). 

Der MasterPort verhält sich beim Einstellen des Universe wie 
neuere Anlagen von Strand Lighting: hier stellt man nur noch 
Vielfache von 512 ein, „XDMX Nr.“ genannt. „Krumme“ Adres-
sen sind nicht möglich. Die realen Kreisnummern von 
1…18432 werden im Routing zusätzlich angezeigt.  

sACN 1… 65279 nicht 
vorhan-
den 

Die Universe-Nummer kann frei eingestellt werden und bildet 
sich in der Multicast-IP-Adresse ab. 

Subnets werden nicht benötigt. 

Bei DMX-IN: Sende-Priorität 0…200 einstellbar. 

 

Wahl des Lichtprotokolls 

Bietet eine Anlage mehrere Lichtprotokolle zur Auswahl, so sollte vom Standpunkt der Netzwerk-
belastung die Rangfolge sein: 

1. ACN 

2. Art-Net 

3. ShowNet 

4. AVAB/UDP 

5. AVAB/IPX 
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Konfiguration für die verschiedenen Lichtprotokolle 

Art-Net 

Da Art-Net die Defaulteinstellung ist, brauchen Sie hierfür an den Netzwerkeinstellungen nichts zu 
verändern. 

Der Empfangstimeout ist 8s, die Senderate ist 1s. 

Das Default-Subnet ist 0 und die Universes 0…3 für die 4 DMX-Ports (egal ob diese In oder Out 
sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort 
schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/IPX 

Schalten Sie den Empfang des Netzwerkprotokolls AVAB/IPX unter Config→Network→Light→ 

Receive ein. Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls AVAB/IPX unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…4 für die 4 DMX-Ports (egal ob diese In oder Out 
sind).Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort 
schalten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/UDP 

Schalten Sie den Empfang des Netzwerkprotokolls AVAB/UDP unter Config→Network→Light→ 

Receive ein. Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls AVAB/UDP unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…4 für die 4 DMX-Ports (egal ob diese In oder Out 
sind). Die Default-Sendepriorität ist 0 (entspricht höchster, immer mergen). Andere Subnets 
und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort schalten Sie die Ports 
auch einzeln ein oder aus. 

 

Per Default hört der MasterPort auch auf Art-Net-Softwaretools und andere Anlagen.  
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ShowNet 

Schalten Sie den Empfang des Netzwerkprotokolls ShowNet unter Config→Network→Light→ 

Receive ein.Empfangstimeout ist 8s. 

 

Schalten Sie das Senden des Netzwerkprotokolls ShowNet unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 4s. 

 

Die Default-Universes (XDMX) sind 1…4 für die 4 DMX-Ports (egal ob diese In oder Out sind). 

Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort schal-
ten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort zwar auf Art-Net-Softwaretools, aber nicht jedes kommt mit den 
192.168er IP-Adressbereichen klar. 

 

sACN 

Schalten Sie den Empfang des Netzwerkprotokolls sACN unter Config→Network→Light→Receive 
ein.Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls sACN unter Config→Network→Light→Transmit 
ein. Stellen Sie die Senderate auf 0,5s. 

 

Die Default-Universes sind 1…4 für die 4 DMX-Ports (egal ob diese In oder Out sind). Die Default-
Sendepriorität ist 0 (entspricht 100).Andere Subnets und/oder Universes stellen Sie unter 
Config→Routing→Port1…4 ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort auch auf Art-Net-Softwaretools und andere Anlagen. 
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Anhang B 

Begriffe 

ACN „Architecture for Control Networks“ 

Von einem internationalen Gremium unter Führung der ESTA standardisierte 
Netzwerkprotokoll-Suite für Geräte im Entertainment Bereich. Beinhaltet sehr 
umfangreiche Mechanismen und Vorgaben für die in den Geräten verwendeten 
Netzwerkprotokolle, Erkennungsmechanismen, Konfigurationsmöglichkeiten mit-
tels XML-Files, Datenübertragungen usw. 

Bisher werden von vielen Herstellern aus Aufwandsgründen (der Standard enthält 
über 400 Seiten) nur Untermengen von ACN implementiert, z.B. die Streaming-
Daten für Licht-Universes (sACN). 

Broadcast In der Netzwerktechnik Protokolle, die an ganze Subnetze (Subnetz-Broadcast) 
oder „an alle“ Netzwerkteilnehmer gesendet werden. Broadcasts sind sehr ineffi-
zient, weil das Netzwerk und alle Teilnehmer belastet werden und sollten daher 
wenn möglich durch Multicast ersetzt werden.  

Broadcasts werden nicht geroutet. 

Broadcasts „an alle“ verwenden in der Lichttechnik z.B. AVAB/IPX und AVAB/UDP. 

Art-Net verwendet zum Teil Subnetz-Broadcasts, was de facto auch einem Broad-
cast für alle Art-Net-Geräte gleichkommt. 

DMX DMX512 

1990 von der USITT vorgeschlagenes Bussystem für Licht- und Medientechnik. 
Später als DIN 56930-2 und ANSI Standard E1.11 festgelegt. 

HTP Highest Takes Precedence 

Übliche Form des Mergens von DMX-Daten: der höchste Wert mehrerer Eingänge 
bestimmt den Ausgabewert. 

IGMP Internet Group Managment Protocol. 

Wird u.a. im Zusammenhang mit Multicast und zur intelligenten Verteilung der 
Netzlast verwendet. Multicast-Teilnehmer melden sich damit z.B. im Netzwerk an 
und ab, um intelligenten Switches mitzuteilen, dass Protokolle ihres Adressbe-
reichs an bestimmten Ports ausgegeben werden sollen. 

Es gibt mittlerweile 3 verschiedene Versionen v1…v3. 

IP Internet Protocol. Computernetzwerkprotokoll, Grundlage des Internet. Erste, 
vom Übertragungsmedium unabhängige Protokollschicht. Ermöglicht eine Adres-
sierung von Netzwerkteilnehmern und Gruppen mittels IP-Adresse und Subnetz-
maske, ist damit auch routingfähig. 

IP-Adresse Netzwerknummer eines Teilnehmers in einem IP-Netz. 32-stellige Binärzahl, wird 
meist als 4-stellige Dezimalzahl im Bereich von 0…255 geschrieben, z.B.  
192.168.0.1. Damit ist jeder Teilnehmer eindeutig identifizierbar. Gruppen von 
Teilnehmern werden über Broadcasts erreicht, wenn die Nummer 255 ist, z.B. 
172.16.100.255 entspricht den Teilnehmern 172.16.100.1 … 172.16.100.254 
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IP-Netzmaske Netzmaske oder Netzwerkmaske, teils noch als Subnetzmaske bezeichnet. Eine 
Bitmaske, die eine IP-Adresse in einen Netzwerk- und einen Geräte- bzw. Hostteil 
trennt. Sie wird in IP-Netzwerken verwendet, um Routing-Entscheidungen zu tref-
fen und Geräte zu bestimmten Gruppen zuzuordnen. Nur Geräte mit gleichem 
Netzwerkteil können direkt miteinander kommunizieren. 

IPX Internetwork Packet eXchange. Von Novell ursprünglich für das Netzwerkbe-
triebssystem NetWare eingeführtes Computer-Netzwerkprotokoll. Verlor seit An-
fang der 90er Jahre gegenüber TCP/IP zunehmend an Bedeutung. In der Licht-
technik werden IPX-Pakete nur vom AVAB/IPX - Lichtprotokoll verwendet. 

Licht-Protokoll Über Ethernet übertragenes Datenprotokoll, das Lichtinformationen überträgt. 
Lichtprotokolle sind herstellerspezifisch und meist nicht offengelegt (Ausnahmen: 
Art-Net, ACN). 

LTP Last Takes Precedence 

Form des Mergens von DMX-Daten: der zuletzt eingetroffene Wert von mehreren 
Eingängen bestimmt den Ausgabewert. Häufig verwendet von beweglicher Me-
chanik wie MovingLights. 

Multicast In der Netzwerktechnik Protokolle, die an mehrere Netzwerkteilnehmer oder 
Gruppen von Teilnehmern gesendet werden. Multicasts sind sehr effizient, weil 
die Teilnehmerfilterung auf Hardwareebene geschieht und Unbeteiligte nicht be-
lastet werden. Multicast-IP-Adressen haben einen eigenen Adressbereich, die 
MAC-Adresse wird von der IP-Adresse abgeleitet. 

In der Lichttechnik wird Multicast z.B. von ACN und ETCNet2 verwendet. 

Intelligente Switches leiten Multicastprotokolle nur zu Teilnehmern, die sich dafür 
beim Switch anmelden. Hierfür gibt es das IGMP-Protokoll. 

Profibus Der international am weitesten verbreitete Industrie-Feldbus, seinerzeit von einer 
Gruppe Hersteller unter Federführung von Siemens entwickelt, in Europa seit lan-
gem standardisiert durch EN50170. Profibus ist physikalisch meist eine RS-485-
Schnittstelle mit zeitlich determiniertem, Token-Ring-ähnlichem Protokoll. Ge-
nauso ist auch Lichtwellenleiter und Profinet (Industrial Ethernet) möglich. Es 
kann mehrere Master und Slaves sowie verschiedene Busprotokolle (FMS, DP,…) 
auf dem Bus geben. 

Dachorganisation PI International mit über 1500 Herstellern, in Deutschland 
durch die PNO vertreten. LSS ist Mitglied der PNO, alle LSS Profibusgeräte sind bei 
der PNO registriert. 

Profibus-DP Auf hohen Datendurchsatz und geringe Übertragungszeiten optimiertes Profibus-
protokoll. Die Daten werden zyklisch und zeitlich determiniert übertragen, wobei 
ein Master jeweils bis zu 125 Slaves ansteuern kann. 

Profibus-DP ist in vielen Siemens S7-CPUs bereits als Standard-Schnittstelle ent-
halten und erfordert somit keinen weiteren Hardwareaufwand. 

RDM Remote Device Managment over DMX512 Networks 

American National Standard (ANSI) E1.20 der ESTA (Entertainment Services and 
Technology Association) 

Erlaubt eine bi-direktionale Übertragung auf dem DMX512-Bus zur Konfiguration, 
Diagnose und Rückmeldung intelligenter DMX-Geräte. 
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Socket Schnittstelle zwischen Ethernet-Empfänger und Firmware des MasterGate. Be-
zeichnet hier den Empfangs- und Sendepuffer für eine Subnet/Universe-
Kombination eines einzelnen Netzwerk-Senders. 

SPS Speicherprogrammierbare Steuerung (z.B: Siemens S7-300/400) 

Stimmungs-
speicher 

Speicher für eine begrenzte Anzahl von beliebigen Lichtprotokollen im MasterGa-
te. Über eine Vielzahl von Steuermöglichkeiten kann so eine komfortable kleine 
Proben- oder Havarielichtanlage realisiert werden. 

Subnet In Lichtprotokollen mancher Hersteller einstellbare Netznummer, dem sich am 
Ethernet angeschlossene Geräte zuordnen lassen. Subnets dienen dazu, die 
Netzwerkstruktur übersichtlich zu gestalten. 

Nicht verwechseln mit IP-Netzmaske! 

TCP Transmission Control Protocol. Zuverlässiges Datenaustauschprotokoll für Com-
puternetzwerke, welches meist auf IP basiert und mit diesem zusammen als 
TCP/IP bezeichnet wird. Die Übertragung erfolgt verbindungsorientiert und gegen 
Übertragungsfehler gesichert. Wird bei Lichtnetzwerken für alle Arten des Daten-
austauschs zwischen Anlagen verwendet, wo es nicht so sehr auf Geschwindig-
keit, sondern auf Sicherheit ankommt. 

UDP User Datagram Protocol. Einfaches Netzwerkprotokoll, welches wie TCP meist auf 
IP basiert. Die Übertragung erfolgt verbindungslos und verlorengegangene Pakete 
werden nicht wiederholt. Ist dafür schneller und hat weniger Verwaltungsauf-
wand. Von vielen Lichtprotokollen für die Lichtdaten verwendet, wo es in erster 
Linie auf Geschwindigkeit und nicht auf Übertragungssicherheit ankommt, da die 
Daten zyklisch wiederholt werden. 

Universe Ethernet-Entsprechung einer DMX-Linie (512 Byte) 
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Anhang C 

Technische Daten 

Allgemeine technische Daten 

Bauart: Panel-Einbaugerät 
CPU-Typ: Infineon XC161 
Taktfrequenz: 40 MHz 
Kühlung: lüfterlos betreibbar 
Abmessungen BxHxT: Frontplatte: 120x120 mm², ca. 5 mm dick 
 Ausschnitt: 105x105 mm², Einbautiefe 66 mm 
Stromversorgung: 48V DC oder  IEEE 802.3af 
Stromaufnahme: 70 mA 
Leistungsaufnahme: 3,5 W 
Gewicht: 500g 
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS-conform: ja 
Konfiguration: Menüsystem mit Display und 4 Tasten 
Lieferumfang: Fertiggerät 
 
 

Schnittstellen 

DMX: 4x XLR 5-pol. 
 
Ethernet: RJ-45 
 IEEE-Belegung für 100BaseTx und 
 Power-over-Ethernet nach IEEE 802.3af 
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DMX 

Allgemein 
DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
Eingänge: einzeln potentialgetrennt  
 (ISOLATED nach ANSI E1.11 A1) 
Ausgänge: einzeln potentialgetrennt 
 (ISOLATED nach ANSI E1.11 A1) 
Potentialtrennung:    Optokoppler 
Isolationsspannung:    1000V DC 

Isolationswiderstand:    109  
EMV: Filterbeschaltung nach Stand der Technik an allen Ein- 

und Ausgängen 
Terminierung: werksseitig intern 
 

Empfang 

Startcode: =0    Lichtprotokoll (in Display ●) 

 <>0  kein Lichtprotokoll, RDM (in Display  E) 
minimale Protokollänge: nur Startcode 
maximale Protokollänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5 ms 
Empfangstimeout: 2 s 
max. Abstand zwischen 2 Protokollen: 2 s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 
Startcode: 0 
Protokollänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4 ms 
Gesendete Protokolle / s: 44 
Breaklänge: 90…999 µs (einstellbar) 
Mark After Break: 20…999 µs (einstellbar) 
Pause nach Startcode: 25 µs 
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Ethernet 

Allgemeines 
Schnittstelle: 10/100 BaseT (IEEE 802.3u, 802.3x) 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.17) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2 
 

Empfang 
Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 
 
 

Senden 
Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s  (einstellbar) 
 
 
 

Bestellnummern 

MasterPort  4 DMX-In   Best.-Nr.: 5040 

MasterPort  2 DMX-In, 2 DMX-Out  Best.-Nr.: 5038 

MasterPort  1 DMX-In, 3 DMX-Out  Best.-Nr.: 5056 

MasterPort  4 DMX-Out   Best.-Nr.: 5039 

 


